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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws
and treaties. No part of this document may be reproduced in any form without the written
authorization of TIBCO Software Inc.

TIBCO, Two-Second Advantage, TIBCO ActiveMatrix BusinessWorks, TIBCO ActiveMatrix
BusinessWorks Plug-in for Marketo, TIBCO Business Studio, and TIBCO Enterprise Administrator are
either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Enterprise Java Beans (EJB), Java Platform Enterprise Edition (Java EE), Java 2 Platform Enterprise
Edition (J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation in the U.S. and other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT
ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED
AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE
VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

Copyright © 2013-2016 TIBCO Software Inc. All rights reserved.

TIBCO Software Inc. Confidential Information
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TIBCO Documentation and Support Services

Documentation for this and other TIBCO products is available on the TIBCO Documentation site. This
site is updated more frequently than any documentation that might be included with the product. To
ensure that you are accessing the latest available help topics, please visit:

https://docs.tibco.com

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site at https://docs.tibco.com/products/tibco-activematrix-businessworks-plug-
in-for-marketo. To directly access documentation for this product, double-click the following file:

TIBCO_HOME/release_notes/TIB_bwpluginmarketo_version_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows,
the default TIBCO_HOME is C:\Program Files\tibco\bw6. On UNIX systems, the default
TIBCO_HOME is /opt/tibco/bw6.

The following documents for this product can be found on the TIBCO Documentation site:

● TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo Installation

● TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo User's Guide

● TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo Release Notes

The following documents provide additional information and can be found on the TIBCO
Documentation site:

● TIBCO ActiveMatrix BusinessWorks documentation

● TIBCO Enterprise Administrator User's Guide

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO Support:

● For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

● If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCO Community

TIBCO Community is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCO Community offers
forums, blogs, and access to a variety of resources. To register, go to the following web address:

https://community.tibco.com
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Plug-in Overview

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Marketo is a software component that adds
customized features to Marketo.

TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo plugs into TIBCO ActiveMatrix
BusinessWorks™ and adds a Marketo Palette to TIBCO Business Studio™.

TIBCO ActiveMatrix BusinessWorks is a leading integration platform that can integrate a wide variety
of technologies and systems within enterprise and on cloud. TIBCO ActiveMatrix BusinessWorks
includes an Eclipse-based graphical user interface (GUI) provided by TIBCO Business Studio for
design, testing, and deployment. If you are not familiar with TIBCO ActiveMatrix BusinessWorks
before using the plug-in, see the TIBCO ActiveMatrix BusinessWorks documentation for more details.

You can use the plug-in to create a connection to a Marketo instance, leverage the Marketo data to
create automations, and move data from your internal systems to the Marketo instance or vice versa.

The plug-in contains the following main features:

Marketo Connection Shared Resource
You can use the Marketo connection shared resource to obtain an access token and metadata. The
shared resource is used by the Marketo activities.

Import Activity
You can use this activity to import leads.

Upsert Activity
You can use this activity to create or update leads, opportunity, opportunity role, company, and
custom objects, add or remove leads from a list, and request or schedule campaigns.

Retrieve Activity
You can use this activity to retrieve resources, such as leads, list, campaigns, import status,
opportunity, opportunity role, company, and custom objects.

Delete Activity
You can use this activity to delete leads, opportunity, opportunity role, company, and custom objects.
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Getting Started

This tutorial is designed for the beginners who want to use TIBCO ActiveMatrix BusinessWorks Plug-in
for Marketo in TIBCO Business Studio.

All the operations are performed in TIBCO Business Studio. See TIBCO Business Studio Overview to
get familiar with TIBCO Business Studio.

A basic procedure of using TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo includes:

1. Creating a Project

2. Creating a Marketo Connection

3. Configuring a Process

4. Testing a Process

5. Deploying an Application

Creating a Project
The first task of using the plug-in is creating a project. After creating a project, you can add resources
and processes.

An Eclipse project is an application module configured for TIBCO ActiveMatrix BusinessWorks. An
application module is the smallest unit of resources that is named, versioned, and packaged as part of
an application.

Procedure

1. Start TIBCO Business Studio by using one of the following ways:

● Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers.

● Mac OS and Linux: run the TIBCO Business Studio executable file located in the TIBCO_HOME/
studio/version_number/eclipse directory.

2. From the menu, click File > New > BusinessWorks Resources to open the BusinessWorks Resource
wizard.

3. In the "Select a wizard" dialog, click BusinessWorks Application Module and click Next to open
the New BusinessWorks Application Module wizard.

4. In the Project dialog, configure the project that you want to create:
a) In the Project name field, enter a project name.
b) By default, the created project is located in the workspace current in use. If you do not want to

use the default location for the project, clear the Use default location check box and click Browse
to select a new location.

c) Use the default version of the application module, or enter a new version in the Version field.
d) Keep the Create empty process and Create Application check boxes selected to automatically

create an empty process and an application when creating the project.
e) Select the Use Java configuration check box if you want to create a Java module.

A Java module provides the Java tooling capabilities.
f) Click Finish to create the project.

Result

The project with the specified settings is displayed in the Project Explorer view.
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Creating a Marketo Connection
After creating a project, you can add a Marketo connection shared resource and configure all the
parameters to connect to a Marketo instance.

Prerequisites

The Marketo connection shared resource is available at the Resources level. Ensure that you have
created a project. For more information, see Creating a Project.

Procedure

1. Expand the created project in the Project Explorer view.

2. Right-click the Resources folder and click New > Marketo Connection to open the Marketo
Connection wizard.

3. The resource folder, package name, and resource name of the Marketo connection are provided by
default. If you do not want to use the default configurations, change them accordingly. Click Finish
to open Marketo Connection Editor.
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4. Configure the Marketo connection in Marketo Connection Editor.
See Marketo Connection regarding the configuration fields.

5. Click Test Connection to validate the connection.

6. Click Refresh/Apply to save lead object fields in the Marketo connection resource file.

Configuring a Process
After creating a project, an empty process is created. You can add activities to the empty process to
complete a task.

Prerequisites

Ensure that you have created an empty process when Creating a Project. If you have not created an
empty process, see TIBCO ActiveMatrix BusinessWorks Application Development for more details about
how to create a process.

Procedure

1. In the Project Explorer view, click the created project and open the empty process from the
Processes folder.

2. Select an activity from the Palette view and drop it in the Process editor.
For example, select and drop the Timer activity from the General Activities palette and the Retrieve
activity from the Marketo palette.
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3. Drag the  icon to create a transition between the added activities.

4. Configure the added Marketo activities. For more information, see Marketo Palette.

A Marketo connection is required when configuring the Marketo activities. See Creating a
Marketo Connection for more details about how to create a Marketo connection.

5. Click File > Save to save the project.

Testing a Process
After configuring a process, you can test the process to check whether the process completes your task.

Prerequisites

Ensure that you have configured a process. For more information, see Configuring a Process.

Procedure

1. On the toolbar, click Debug  > Debug Configurations.

2. Click BusinessWorks Application > BWApplication in the left panel.
By default, all the applications in the current workspace are selected in the Applications tab. Ensure
that only the application you want to debug is selected in the Applications tab in the right panel.

3. Click Debug to test the process in the selected application.
TIBCO Business Studio changes to the Debug perspective. The debug information is displayed in
the Console view.
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4. In the Debug tab, expand the running process and click an activity.

5. In the upper-right corner, click the Job Data tab, and then click the Output tab to check the activity
output.

Deploying an Application
After testing, if the configured process works as expected, you can deploy the application that contains
the configured process into a runtime environment, and then use the bwadmin utility to manage the
deployed application.

Before deploying an application, you must generate an application archive, which is an enterprise
archive (EAR) file that is created in TIBCO Business Studio. See TIBCO Business Studio Overview to get
familiar with TIBCO Business Studio.

Deploying an application involves the following tasks:

1. Uploading an application archive

2. Deploying an application archive

3. Starting an application

See TIBCO ActiveMatrix BusinessWorks Administration for more details about how to deploy an
application.

TIBCO Business Studio Overview
TIBCO Business Studio is an Eclipse-based integration development environment that is used to
design, develop, and test ActiveMatrix BusinessWorks applications.

TIBCO Business Studio provides a workbench in which you can create, manage, and navigate resources
in your workspace. A workspace is the central location on your machine where all data files are stored.
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The workbench consists of:

1. Menu: contains menu items, such as File, Edit, Diagram, Navigate, Search, Project, Run, Window,
and Help.

2. Toolbar: contains buttons for frequently used commands, such as New  , Save  , Enable/

Disable Business Studio Capabilities  , Create a new BusinessWorks Application Module  ,

Create a new BusinessWorks Shared Module  , Debug  , Run  , and so on.

3. Perspective: contains an initial set and layout of views that are required to perform a certain task.
TIBCO Business Studio launches the Modeling perspective by default. You can change the
perspective from the menu Window > Open Perspective > Perspective_Name.

4. View: displays resources. For example, the Project Explorer view displays the ActiveMatrix
BusinessWorks applications, modules, and other resources in your workspace, and the Properties
view displays the properties for the selected resource. You can open a view from the menu Window
> Show View > View_Name.

5. Editor: provides a canvas to configure, edit, or browse a resource. Double-click a resource in a view
to open the appropriate editor for the selected resource. For example, double-click an ActiveMatrix
BusinessWorks process (MortgageAppConsumer.bwp) in the Project Explorer view to open the
process in the editor.

6. Palette: contains a set of widgets and a palette library. A palette groups activities that perform similar
tasks, and provides quick access to activities when configuring a process.
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Marketo Connection

The Marketo connection shared resource contains all the parameters required to connect to Marketo
REST API. The Marketo connection shared resource is used by all the activities in the Marketo palette.

General

In the General panel, you can specify the package that stores the Marketo connection shared resource
and the shared resource name.

The following table lists the fields in the General panel:

Field
Module
Property? Description

Package No The name of the package where the shared resource is added.

Name No The name to be displayed as the label for the shared resource in
the process.

Description No A short description for the shared resource.

Marketo Connection Configuration

In the Marketo Connection Configuration panel, you can provide the information of the Marketo
instance that the plug-in connects to. The Marketo Connection Configuration panel contains the
following fields. For more information about REST API of your Marketo account, see the Marketo REST
API documentation.

Field
Module
Property? Description

REST Endpoint Yes The endpoint to connect to Marketo REST API.

Identity Service
URL

Yes The identity service URL used to generate an access token.

Client Id Yes The client ID used to connect to Marketo REST API.

Client Secret Yes The client secret used to generate an access token.

Test
Connection

No You can use this button to test whether the specified configuration
fields result in a valid connection to your Marketo instance.

Refresh/Apply No You can use this button to fetch metadata from the URL specified
in the REST Endpoint field. The metadata is saved in the Schemas
folder.

If you create or modify custom fields in Marketo, click
Refresh/Apply to update metadata. The created or
modified custom fields are displayed in the activities
when this shared resource is used.

For more information about Client Id and Client Secret, see the Marketo documentation.
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Advanced

In the Advanced panel, you can configure a proxy.

The following table lists the fields in the Advanced panel:

Field
Module
Property? Description

Retry Count Yes Specifies the number of attempts that the plug-in connects to
Marketo REST APIs when connecting to a Marketo instance. The
default value is 0.

Retry Interval Yes Specifies an interval between HTTP connection retries. The default
value is 3000 milliseconds.

Proxy
Configuration

No Specifies a proxy HTTP server when HTTP requests are sent
outside of a firewall. For more detailed information about Proxy
Configuration, see TIBCO ActiveMatrix BusinessWorks Bindings and
Palettes Reference, Section, "Shared Resources."

The proxy server only supports the Retrieve, Upsert, and
Delete activities.
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Marketo Palette

A palette groups the activities that connect the same external applications. A Marketo palette is added
after installing TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo.

The Marketo palette contains the following activities:

● Import

● Upsert

● Retrieve

● Delete

Import
Use the Import activity to import leads.

You can use the Retrieve activity to check the status of the import operation. The Import activity does
not support concurrency.

General Tab
In the General tab, you can specify the required fields before you use the Import activity.

The following table lists the configurations in the General tab of the Import activity:

Field
Module
Property? Description

Name No The name to be displayed as the label for the activity in the process.

Marketo
Connection

Yes Click Choose/Create Default Resource  to select a Marketo shared
resource.

If no matching Marketo shared resources are found, click Create
Shared Resource to create one. See Creating a Marketo Connection for
more details.

Timeout Yes The amount of time in milliseconds before the HTTP connection is
stopped if Marketo does not send any response.

The value in this field is set to 30000 by default.

Description Tab
In the Description tab, you can enter a short description for the Import activity.

Input and Output Tabs
In the Input tab, you can specify the fields that you require. In the Output tab, you can check the
response information.

The following table lists the input elements in the Input tab of the Import activity:
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Input Item
Data
Type Description

format String The supported file formats: csv (comma separated value), tsv (tab
separated value), and ssv (semicolon separated value).

lookupField String This parameter functions as a lookup field for reduplication.

listId String If a list ID is not specified, this API operation creates a temporary
static list. The workspace for the list is determined whether the
partitionName is given or not.

partitionName String If a list ID is specified, this parameter verifies whether the user has
access to the partition. If not specified, this API operation uses a
primary partition of the list workspace.

file String A file path. Lead data is specified through multipart form data in
the file.

The following table lists the output elements in the Output tab of the Import activity:

Output Item
Data
Type Description

requestId String The request ID returned from the Marketo server.

success Boolean If the request is successful, this value is true.

result Complex The fields that are displayed in the response. The following fields
are displayed: batchId and status. The batchId field is used to get
import status in the Retrieve activity.

Fault Tab
In the Fault tab, you can find the error code and error message of the Import activity.

For more detailed information, see Error Codes.

The following table lists the error schema elements in the Fault tab of the Import activity:

Error Schema
Element Data Type Description

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that occur when establishing the web service
connection between the plug-in and Marketo.
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Error Schema
Element Data Type Description

msgCode String The error code that is returned when establishing the web service
connection between the plug-in and Marketo.

Upsert
Use the Upsert activity to create or update leads, opportunity, opportunity role, company, and custom
objects, add or remove leads from a list, and request or schedule campaigns.

General Tab
In the General tab, you can specify the required fields before you use the Upsert activity.

The following table lists the configurations in the General tab of the Upsert activity:

Field
Module
Property? Description

Name No The name to be displayed as the label for the activity in the process.

Marketo
Connection

Yes Click Choose/Create Default Resource  to select a Marketo
shared resource.

If no matching Marketo shared resources are found, click Create
Shared Resource to create one. See Creating a Marketo Connection
for more details.

Timeout Yes The amount of time in milliseconds before the HTTP connection is
stopped if Marketo does not send any response. .

The value in this field is set to 30000 by default.

Resource No A resource type to be upserted. The following resource types are
available: Leads, List, Campaigns, Opportunity, Opportunity Role,
Company, and Custom Objects.
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Field
Module
Property? Description

Endpoint No An endpoint to be upserted. The actual endpoints vary according to
the following resources that you specified.

This field is available only when you select the Leads, List,
Campaigns, and Custom Objects resource.

If you select the Leads resource, the following endpoints are
available:

● Multiple Leads: you can create new leads within Marketo, or if
the lead already exists, you can update it with the new values.

● Associate: you can associate a lead with a cookie value. For
example, you have the cookie value for an anonymous lead in
Marketo, and you want to associate this anonymous lead data
with a known lead.

● Merge: you can merge leads.

If you select the List resource, the following endpoints are available:

● Add Leads: you can add one or multiple leads to a list.

● Remove Leads: you can remove one or multiple leads from a list.

If you select the Campaigns resource, the following endpoints are
available:

● Schedule Campaign: you can schedule a batch smart campaign to
run either immediately or at a future date.

● Request Campaign: you can run an existing Marketo lead in a
Marketo smart campaign. The smart campaign must have a
Campaign is Requested trigger with a Web Service API source.

If you select the Custom Objects resource, the endpoints that you
created are available.

Description Tab
In the Description tab, you can enter a short description for the Upsert activity.

Field Selector Tab
In the Field Selector tab, you can select the fields that are used for updating leads. In the Upsert
activity, the Field Selector tab only supports Upsert Multiple Leads API.

You can choose the fields that you require by selecting the check box on the left of the panel. Or you can
choose all of the fields by clicking Select All in the upper-left corner of the panel.

When you add, update, or hide any custom fields in Field Management on a Marketo instance, click
Refresh/Apply in Marketo Connection Shared Resource, and then you can sync the fields in the Field
Selector tab by clicking any other tab and switching back to the Field selector tab. If the Marketo fields
are not updated, retry it in 5-10 minutes.

Before using this tab, ensure that you have selected a Marketo shared resource.
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Input and Output Tabs
In the Input tab, you can specify the fields that you require. In the Output tab, you can check the
response information.

The information in the Input and Output tabs varies depending on the resource and the endpoint that
you select.

● If you select the Leads resource, see Input and Output of Upsert Leads for more details.

● If you select the List resource, see Input and Output of Upsert List for more details.

● If you select the Campaigns resource, see Input and Output of Upsert Campaigns for more details.

● If you select the Opportunity resource, see Input and Output of Upsert Opportunity for more
details.

● If you select the Opportunity Role resource, see Input and Output of Upsert Opportunity Role for
more details.

● If you select the Company resource, see Input and Output of Upsert Company for more details.

● If you select the Custom Objects resource, see Input and Output of Upsert Custom Objects for more
details.

Input and Output of Upsert Leads

When you use the Leads resource, the information in the Input and Output tabs varies depending on
the endpoint that you select.

Input and Output for Multiple Leads

If you select the Multiple Leads endpoint, the Input tab contains the following elements:

Input Item Data Type Description

action String Possible values: createOnly, updateOnly, createOrUpdate
(default request), and createDuplicate.

lookupField String If specified, the plug-in uses this attribute to find the duplicate. If
the lookup field is not specified, the email is used to find the
duplicate. If you used other fields, you can select the fields in
Field Selector tab and it is shown under the input element, and
you can input values.

input Complex An array of lead records that you create or update. The
following fields are displayed: email, firstName, and
postalCode. If the fields in the Field Selector tab are selected,
these fields are added to the input fields.

asyncProcessing Boolean The post processing when calling the creating or updating leads.
The default value is false.

partitionName String A lead partition name. If you set up a lead partition in an
instance, specify a partition name when you do an upsert call.

The Output tab contains the following elements:
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Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output for Associate

If you select the Associate endpoint, the Input tab contains the following elements:

Input Item Data Type Description

id Integer A known lead ID.

cookie String The cookie value of a lead.

The Output tab contains the following elements :

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output for Merge Leads

If you select the Merge endpoint, the Input tab contains the following elements:

Input Item Data Type Description

id Integer A winning lead ID.

leadIds Complex A separated list of losing lead IDs.

mergeInCRM Boolean Set true to merge in CRM.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.
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Input and Output of Upsert List

When you use the List resource, the information in the Input and Output tabs varies depending on the
endpoint that you select.

Input and Output for Add Leads

If you select the Add Leads endpoint, the Input tab contains the following elements:

Input Item Data Type Description

listId String The ID of the list.

Ids Complex The IDs of the leads to be added to the list. Multiple IDs are
supported.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output for Remove Leads

If you select the Remove Leads endpoint, the Input tab contains the following elements:

Input Item Data Type Description

listId String The ID of the list.

Ids Complex The IDs of the leads to be removed from the list. Multiple IDs are
supported.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.
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Input and Output of Upsert Campaigns

When you use the Campaigns resource, the information in the Input and Output tabs varies depending
on the endpoint that you select.

Input and Output for Schedule Campaign

If you select the Schedule Campaign endpoint, the Input tab contains the following elements:

Input Item
Data
Type Description

id String A Marketo ID of the campaign that you want to run.

runAt DateTime The time to run the scheduled campaign. If not provided,
schedule it to run in five minutes.

cloneToProgramN

ame

String When this parameter is present, the parent program of the
campaign is cloned and the newly created campaign is scheduled.
This parameter specifies the desired name for the resulting
program.

Only 20 calls per day are used when this attribute is
available.

tokens Complex An array of token names and token value pairs.

The Output tab contains the following elements:

Output Item
Data
Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output for Request Campaign

If you select the Request Campaign endpoint, the Input tab contains the following elements:

Input Item Data Type Description

id String A Marketo ID of the campaign that you want to run.

leads Complex A list of lead IDs of an integer data type.

tokens Complex An array of token names and token value pairs.

The Output tab contains the following elements:
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Output item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output of Upsert Opportunity

When you use the Opportunity resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Opportunity resource:

Input Item Data Type Description

action String An action to be performed. Possible values: createOnly,
updateOnly, createOrUpdate (default request), and
createDuplicate.

dedupeBy String The deduplication method. Possible values: idField and
dedupeFields (default).

This field is valid only when you use the updateOnly
action.

object Complex An array of opportunity records that you create or update. If the
fields in the Field Selector tab are selected, these fields are added
to the object node.

The following table lists the output elements in the Output tab of the Opportunity resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: seq, marketoGUID, status, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Upsert Opportunity Role

When you use the Opportunity Role resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Opportunity Role resource:
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Input Item Data Type Description

action String An action to be performed. Possible values: createOnly,
updateOnly, createOrUpdate (default request), and
createDuplicate.

dedupeBy String The deduplication method. Possible values: idField and
dedupeFields (default).

This field is valid only when you use the updateOnly
action.

object Complex An array of lead records that you create or update. If the fields in
the Field Selector tab are selected, these fields are added to the
object node.

The following table lists the output elements in the Output tab of the Opportunity Role resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: seq, marketoGUID, status, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Upsert Company

When you use the Company resource, the information in the Input and Output tabs varies depending
on the endpoint that you select.

The following table lists the input elements in the Input tab of the Company resource:

Input Item Data Type Description

action String An action to be performed. Possible values: createOnly,
updateOnly, createOrUpdate (default request), and
createDuplicate.

dedupeBy String The deduplication method. Possible values: idField and
dedupeFields (default).

This field is valid only when you use the updateOnly
action.

object Complex An array of lead records that you create or update. If the fields in
the Field Selector tab are selected, these fields are added to the
object node.

The following table lists the output elements in the Output tab of the Company resource:
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Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: seq, id, status, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Upsert Custom Objects

When you use the Custom Objects resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Custom Objects resource:

Input Item Data Type Description

action String An action to be performed. Possible values: createOnly,
updateOnly, createOrUpdate (default request), and
createDuplicate.

dedupeBy String The deduplication method. Possible values: idField and
dedupeFields (default).

This field is valid only when you use the updateOnly
action.

object Complex An array of custom object records that you create or update. If
the fields in the Field Selector tab are selected, these fields are
added to the object node.

The following table lists the output elements in the Output tab of the Custom Objects resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: seq, status, marketoGUID, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Fault Tab
In the Fault tab, you can find the error code and error message of the Upsert activity.

For more detailed information, see Error Codes.

The following table lists the error schema elements in the Fault tab of the Upsert activity:
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Error Schema
Element

Data
Type Description

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that occur when establishing the web service
connection between the plug-in and Marketo.

msgCode String The error code that is returned when establishing the web service
connection between the plug-in and Marketo.

Retrieve
Use the Retrieve activity to retrieve leads, list, campaigns, import status, opportunity, opportunity role,
company, and custom objects.

General Tab
In the General tab, you can specify the required fields before you use the Retrieve activity.

The following table lists the configurations in the General tab of the Retrieve activity:

Field
Module
Property? Description

Name No The name to be displayed as the label for the activity in the
process.

Marketo
Connection

Yes Click Choose/Create Default Resource  to select a
Marketo shared resource.

If no matching Marketo shared resources are found, click
Create Shared Resource to create one. See Creating a
Marketo Connection for more details.

Timeout Yes The amount of time in milliseconds before you can execute
the retrieve operation.

The value in this field is set to 30000 by default.

Resource No The resource types to be retrieved. The following resource
types are available: Leads, List, Campaigns, Import Status,
Opportunity, Opportunity Role, Company, and Custom
Objects.
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Field
Module
Property? Description

Endpoint No An endpoint to be retrieved. The actual endpoint varies
according to the following resources that you specified. For
more detailed information, see the Marketo documentation.

This field is available only when you select the
Leads, List, Campaigns, Import Status, and
Custom Objects resource.

If you select the Leads resource, the following endpoints are
available:

● Lead by Id: you can retrieve a single lead record from
Marketo, with fields requested for a lead identified by the
lead ID.

● Multiple Leads: you can retrieve the lead records from
Marketo for a group of leads that match the filter criteria.

● Multiple Leads by List: you can retrieve multiple leads
from a given list ID.

● Lead Activity: you can retrieve activities for the requested
activity types, such as form fill out or lead creation.

● Lead Changes: you can retrieve change data value for
leads.

If you select the List resource, the following endpoints are
available:

● List by Id: you can retrieve a single list using the list ID.

● Multiple Lists: you can retrieve multiple lists through
some filters. For example, IDs, names, programNames,
and workspaceNames.

● Member of List: you can check whether leads are a
member of list.

If you select the Campaigns resource, the following
endpoints are available:

● Campaign by Id: you can retrieve a campaign using a
campaign ID.

● Multiple Campaigns: you can retrieve multiple
campaigns.

If you select the Import Status resource, the following
endpoints are available:

● Status: you can check the status of lead operation from an
import lead API call.

● Warning File: you can retrieve the warning file from an
import lead API call.

● Failure File: you can retrieve the failure file from an
import lead API call.
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Field
Module
Property? Description

If you select the Custom Objects resource, the endpoints that
you created are available.

Description Tab
In the Description tab, you can enter a short description for the Retrieve activity.

Field Selector Tab
In the Field Selector tab, you can retrieve the leads by selecting the fields that you want. In the Retrieve
activity, the Field Selector tab only supports Retrieve Lead by Id, Retrieve Multiple Leads, Retrieve
Multiple Leads by List, and Retrieve Lead Changes APIs.

You can choose the fields that you require by selecting the check box on the left of the panel. Or you can
choose all of the fields by clicking Select All in the upper-left corner of the panel.

When you add, update, or hide any custom fields in Field Management on a Marketo instance, click
Refresh/Apply in Marketo Connection Shared Resource, and then you can sync the fields in the Field
Selector tab by clicking any other tab and switching back to the Field selector tab. If the Marketo fields
are not updated, retry it in 5-10 minutes.

Before using this tab, ensure that you have selected a Marketo shared resource.

Input and Output Tabs
In the Input tab, you can specify the fields that you require. In the Output tab, you can check the
response information.

The information in the Input and Output tabs varies depending on the resource and the endpoint that
you select.

● If you select the Leads resource, see Input and Output of Retrieve Leads for more details.

● If you select the List resource, see Input and Output of Retrieve List for more details.

● If you select the Campaigns resource, see Input and Output of Retrieve Campaigns for more details.

● If you select the Import Status resource, see Input and Output of Retrieve Import Status for more
details.

● If you select the Opportunity resource, see Input and Output of Retrieve Opportunity for more
details.

● If you select the Opportunity Role resource, see Input and Output of Retrieve Opportunity Role for
more details.

● If you select the Company resource, see Input and Output of Retrieve Company for more details.

● If you select the Custom Objects resource, see Input and Output of Retrieve Custom Objects for
more details.

Input and Output of Retrieve Leads

When you use the Leads resource, the information in the Input and Output tabs varies depending on
the endpoint that you select.

Input and Output for Lead by Id

If you select the Lead by Id endpoint, the Input tab contains the following element:
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Input Item Data Type Description

id Integer The ID of the lead.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. If no fields are
selected in the Field Selector tab, the following fields are
displayed: id, updatedAt, lastName, email, createdAt, and
firstName. If you select a field in the Field Selector tab, the field
corresponding to this field is displayed in the Output tab under the
fields element.

success Boolean If the request is successful, this value is true.

Input and Output for Multiple Leads

If you select the Multiple Leads endpoint, the Input tab contains the following elements:

Input Item Data Type Description

filterType String The filter types supported by Marketo. For example, Id, cookie,
email, twitterId and so on.

If you use a field such as filterValues, ensure that the
field is displayed in the response. If the field is not
displayed, you have to click the Field Selector tab and
select the field.

filterValues Complex A separated list of filter values.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.
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Output Item Data Type Description

result Complex The fields that are displayed in the response. If no fields are
selected in the Field Selector tab, the following fields are returned:
id, email, updatedAt, createdAt, lastName, firstName, cookies,
twitterId, facebookId, linkedInId, sfdcAccountId, sfdcContactId,
sfdcLeadId, and sfdcLeadOwnerId.

If you select a field in the Field Selector tab, the field
corresponding to this field is displayed in the Output tab.

success Boolean If the request is successful, this value is true.

nextPageToken String This parameter is returned by an API call. This value can be used
to access next set of records.

Input and Output for Multiple Leads by List

If you select the Multiple Leads by List endpoint, the Input tab contains the following elements:

Input Item Data Type Description

listId String The ID of the list that you want to retrieve.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. If no fields are
selected in the Field Selector tab, the following fields are returned:
id, email, updatedAt, createdAt, lastName, and firstName. If you
select a field in the Field Selector tab, the field corresponding to
this field is displayed in the Output tab.

success Boolean If the request is successful, this value is true.

nextPageToken String This parameter is returned by an API call. This value can be used
to access next set of records.

Input and Output for Lead Activity

If you select the Lead Activity endpoint, the Input tab contains the following elements:
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Input Item Data Type Description

activityTypeIds Complex The ID of the activity type that you want to request. The default
maximum number of the multiple type is 10.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

listId String This parameter serves as a filter, and returns leads that belong to
a specified list activities for leads in the given list.

sinceDatetime DateTime This parameter is used to get the lead activities since the date
time is specified. It is usually used in the first call.

For all the Datetime type in the plug-in, it supports
XSD Datetime type format. For example,
2002-05-30T09:00:00, 2014-10-06T13:22:17-08:00. It does
not support 2014-10-06T13:22-07:00, 2014-10-06.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, leadId, activityDate, activityTypeId,
primaryAttributeValueId, primaryAttributeValue, and
attributes.

success Boolean If the request is successful, this value is true.

nextPageToken String This parameter is returned by an API call. This value can be used
to access next set of records.

moreResult Boolean If this value is true, more results are available.

Input and Output for Lead Changes

If you select the Lead Changes endpoint, the Input tab contains the following elements:
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Input Item Data Type Description

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

listId String This parameter serves as a filter, and returns leads that belong to a
specified list activities for leads in the given list.

sinceDatetime DateTime This parameter is used to get the lead activities since the date time
is specified. It is usually used in the first call.

For all the Datetime type in the plug-in, it supports XSD
Datetime type format. For example, 2002-05-30T09:00:00,
2014-10-06T13:22:17-08:00. It does not support
2014-10-06T13:22-07:00, 2014-10-06.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response and the following
fields are displayed: id, leadId, activityDate, activityTypeId,
attributes, and fields.

success Boolean If the request is successful, this value is true.

nextPageToken String This parameter is returned by an API call. This value can be used
to access next set of records.

moreResult Boolean If this value is true, more results are available.

Input and Output of Retrieve List

When you use the List resource, the information in the Input and Output tabs varies depending on the
endpoint that you select.

Input and Output for List by Id

If you select the List by Id endpoint, the Input tab contains the following element:

Input Item Data Type Description

id String The ID of the list that you retrieve.

The Output tab contains the following elements:
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Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, name, description, programName,
workspaceName, createdAt, and updatedAt.

success Boolean If the request is successful, this value is true.

Input and Output for Multiple Lists

If you select the Multiple Lists endpoint, the Input tab contains the following elements:

Input Item
Data
Type Description

ids Complex The IDs of the lists. Multiple list IDs are supported.

names Complex The names of the lists. Multiple list names are supported.

programNames Complex The program names of the lists. Multiple program names are
supported.

workspaceNames Complex The workspace names of the lists. Multiple workspace names
are supported.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

nextPageToken String This parameter is used to paginate through large result sets.
This value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, name, description, programName,
workspaceName, createdAt, and updatedAt.

success Boolean If the request is successful, this value is true.

nextPageToken String This parameter is returned by an API call. This value can be used
to access next set of records.

Input and Output for Member of List

If you select the Member of List endpoint, the Input tab contains the following elements:
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Input Item Data Type Description

listid String The ID of the list.

ids Complex The IDs of the leads.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output of Retrieve Campaigns

When you use the Campaigns resource, the information in the Input and Output tabs varies depending
on the endpoint that you select.

Input and Output for Campaign by Id

If you select the Campaign by Id endpoint, the Input tab contains the following element:

Input Item Data Type Description

id String The ID of the campaign.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: id, name, description, programName, createdAt,
updatedAt, type, workspaceName, and active.

success Boolean If the request is successful, this value is true.

Input and Output for Multiple Campaigns

If you select the Multiple Campaigns endpoint, the Input tab contains the following elements:

Input Item Data Type Description

ids Complex The ID of the campaign. Multiple campaign IDs are supported.

names Complex The name of the campaign. Multiple campaign names are
supported.
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Input Item Data Type Description

programNames Complex The program name of the campaign. Multiple program names
are supported.

workspaceNames Complex The workspace name of the campaign. Multiple workspace
names are supported.

batchSize Integer The maximum number of records to be returned in a single call.
The default maximum number of the batch size is 300.

nextPageToken String This parameter is used to paginate through large result sets.
This value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

The Output tab contains the following elements:

Output Item
Data
Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: id, name, description, programName, createdAt,
updatedAt, type, workspaceName, and active.

success Boolean If the request is successful, this value is true.

nextPageToken String This token is returned by an API call. This value can be used to access
next set of records.

Input and Output of Retrieve Import Status

When you use the Import Status resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

Input and Output for Status

If you select the Status endpoint, the Input tab contains the following element:

Input Item Data Type Description

id String The batch ID received from the import lead call.

The Output tab contains the following elements:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.
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Output Item Data Type Description

result Complex The fields that are displayed in the response. The following fields
are displayed: batchId, status, numOfLeadsProcessed,
numOfRowsFailed, numOfRowsWithWarning, and message.

success Boolean If the request is successful, this value is true.

Input and Output for Warning File

If you select the Warning File endpoint, the Input tab contains the following elements:

Input Item Data Type Description

id String The batch ID received from an import lead call.

fileName String The path of the returned file.

The Output tab contains the following element:

Output Item Data Type Description

fileName String The path of the returned file.

Input and Output for Failure File

If you select the Failure File endpoint, the Input tab contains the following elements:

Input Item Data Type Description

id String The batch ID returned from the import lead call.

fileName String The path of the returned file.

The Output tab contains the following element:

Output Item Data Type Description

fileName String The path of the returned file.

Input and Output of Retrieve Opportunity

When you use the Opportunity resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Opportunity resource:
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Input Item Data Type Description

filterType String The filter types supported by Marketo. Possible values: idField,
dedupeFields, externalCompanyId, and
externalSalesPersonId.

You can only use the filterValues field for idField.

You can only use the corresponding fields in the Object
node for dedupeFields.

filterValues String A separated list of filter values.

You cannot specify the values of multiple fields in this
field.

Object Complex The multiple fields for filtering. If no fields are selected in the Field
Selector tab, the following fields are displayed:
externalOpportunityId, amount, closeDate, description,
expectedRevenue, externalCompanyId, externalCreatedDate,
externalSalesPersonId, fiscal, fiscalQuarter, fiscalYear,
forecastCategoryName, isClosed, isWon, lastActivityDate,
leadSource, name, nextStep, probability, quantity, stage, and
type. If the fields in the Field Selector tab are selected, these fields
are added to the object node.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

The following table lists the output elements in the Output tab of the Opportunity resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: reasons, seq, marketoGUID, updatedAt, and
createdAt.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Retrieve Opportunity Role

When you use the Opportunity Role resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Opportunity Role resource:
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Input Item Data Type Description

filterType String The filter types supported by Marketo. Possible values: idField,
dedupeFields, externalOpportunityId, and LeadId.

You can only use the filterValues field for idField.

filterValues String A separated list of filter values.

You cannot specify the values of multiple fields in this
field.

Object Complex The multiple fields for filtering. If no fields are selected in the Field
Selector tab, the following fields are displayed:
externalCreatedDate, externalOpportunityId, isPrimary, leadID,
and role. If the fields in the Field Selector tab are selected, these
fields are added to the object node.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

The following table lists the output elements in the Output tab of the Opportunity Role resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: seq, marketoGUID, status, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Retrieve Company

When you use the Company resource, the information in the Input and Output tabs varies depending
on the endpoint that you select.

The following table lists the input elements in the Input tab of the Company resource:

Input Item Data Type Description

filterType String The filter types supported by Marketo. Possible values: idField,
dedupeFields, externalSalesPersionId, and Company.

You can only use the filterValues field for idField.
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Input Item Data Type Description

filterValues String A separated list of filter values.

You cannot specify the values of multiple fields in this
field.

Object Complex The multiple fields for filtering. If no fields are selected in the Field
Selector tab, the following fields are displayed:
externalCompanyId, annualRevenue, billingCity,
billingCountry, billingPostalCode, billingState, billingStreet,
company, companyNotes, externalSalesPersonId, industry,
mainPhone, numberOfEmployees, sicCode, site, and website. If
the fields in the Field Selector tab are selected, these fields are
added to the object node.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize Integer The maximum number of records to be returned. The default
maximum number of the batch size is 300.

The following table lists the output elements in the Output tab of the Company resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: reasons, seq, id, updatedAt, and createdAt.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Retrieve Custom Objects

When you use the Custom Objects resource, the information in the Input and Output tabs varies
depending on the endpoint that you select.

The following table lists the input elements in the Input tab of the Custom Objects resource:

Input Item
Data
Type Description

Id String The ID of the custom object.

filterType String The filter types that you created in the custom object, such as
idField, dedupeFields and other searchable fields.
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Input Item
Data
Type Description

filterValues String A separated list of filter values.

You cannot specify the values of multiple fields in this
field.

object Complex An array of custom object records that you retrieve. If the fields in
the Field Selector tab are selected, these fields are added to the
object node.

nextPageToken String This parameter is used to paginate through large result sets. This
value can be used to access next set of records.

The value of the next page token is obtained from the
output of the previous activity.

batchSize String The maximum number of records to be returned. The default
maximum number of the batch size is 300.

The following table lists the output elements in the Output tab of the Custom Objects resource:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: reasons, seq, marketoGUID, updateAt, and createdAt.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Fault Tab
In the Fault tab, you can find the error code and error message of the Retrieve activity.

For more detailed information, see Error Codes.

The following table lists the error schema elements in the Fault tab of the Retrieve activity:

Error Schema
Elements Data Type Description

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that occur when establishing the web service
connection between the plug-in and Marketo.
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Error Schema
Elements Data Type Description

msgCode String The error code that is returned when establishing the web
service connection between the plug-in and Marketo.

Delete
Use the Delete activity to delete leads, opportunity, opportunity role, company, and custom objects.

General Tab
In the General tab, you can specify the required fields before you use the Delete activity.

The following table lists the configurations in the General tab of the Delete activity:

Field

Module
Property
? Description

Name No The name to be displayed as the label for the activity in the process.

Marketo
Connection

Yes Click Choose/Create Default Resource  to select a Marketo
shared resource.

If no matching Marketo shared resources are found, click Create
Shared Resource to create one. See Creating a Marketo Connection
for more details.

Timeout Yes The amount of time in milliseconds before you can execute the
retrieve operation.

The value in this field is set to 30000 by default.

Options No The options to be deleted. The following options are available:
Leads, Opportunity, Opportunity Role, Company, and Custom
Objects.

Objects No If you select the Custom Objects option, the custom objects that
you created are available.

This field is available only when you select the Custom
Objects option.

Description Tab
In the Description tab, you can enter a short description for the Delete activity.

Input and Output Tabs
In the Input tab, you can specify the fields that you require. In the Output tab, you can check the
response information.

The information in the Input and Output tabs varies depending on the option and the object that you
select.

● If you select the Leads option, see Input and Output of Delete Leads for more details.
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● If you select the Opportunity option, see Input and Output of Delete Opportunity for more details.

● If you select the Opportunity Role option, see Input and Output of Delete Opportunity Role for
more details.

● If you select the Company option, see Input and Output of Delete Company for more details.

● If you select the Custom Objects option, see Input and Output of Delete Custom Objects for more
details.

Input and Output Tab of Delete Leads

When you use the Leads option, you can specify the fields that you require in the Input tab and check
the response information in the Output tab.

The following table lists the input element in the Input tab of the Leads option:

Input Item Data Type Description

id Integer The lead ID or multiple lead IDs that you want to delete.

The following table lists the output elements in the Output tab of the Leads option:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields
are displayed: id, status, and reasons.

success Boolean If the request is successful, this value is true.

Input and Output of Delete Opportunity

When you use the Opportunity option, you can specify the fields that you require in the Input tab and
check the response information in the Output tab.

The following table lists the input elements in the Input tab of the Opportunity option:

Input Item Data Type Description

deleteBy String The deletion method. Possible values: idField or dedupeFields.

input Complex Deletion criteria. If the fields in the Field Selector tab are selected,
these fields are added to the input node.

The following table lists the output elements in the Output tab of the Opportunity option:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: seq, marketoGUID, status, and reasons.
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Output Item Data Type Description

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Delete Opportunity Role

When you use the Opportunity Role option, you can specify the fields that you require in the Input tab
and check the response information in the Output tab.

The following table lists the input elements in the Input tab of the Opportunity Role option:

Input Item Data Type Description

deleteBy String The deletion method. Possible values: idField or dedupeFields.

input Complex Deletion criteria. If the fields in the Field Selector tab are selected,
these fields are added to the input node.

The following table lists the output elements in the Output tab of the Opportunity Role option:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: reasons, seq, marketoGUID, updatedAt, and createdAt.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Delete Company

When you use the Company option, you can specify the fields that you require in the Input tab and
check the response information in the Output tab.

The following table lists the input elements in the Input tab of the Company option:

Input Item Data Type Description

deleteBy String The deletion method. Possible values: idField or dedupeFields.

input Complex Deletion criteria. If the fields in the Field Selector tab are selected,
these fields are added to the input node.

The following table lists the output elements in the Output tab of the Company option:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.
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Output Item Data Type Description

result Complex The fields that are displayed in the response. The following fields are
displayed: seq, id, status, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Input and Output of Delete Custom Objects

When you use the Custom Objects option, the information in the Input and Output tabs varies
depending on the objects that you select.

The following table lists the input elements in the Input tab of the Custom Objects option:

Input Item Data Type Description

deleteBy String The deletion method. Possible values: idField or dedupeFields.

input Complex Deletion criteria. If the fields in the Field Selector tab are selected,
these fields are added to the input node.

The following table lists the output elements in the Output tab of the Custom Objects option:

Output Item Data Type Description

requestId String The request ID returned from the Marketo server.

result Complex The fields that are displayed in the response. The following fields are
displayed: seq, status, marketoGUID, and reasons.

success Boolean If the request is successful, this value is true.

errors Complex The error codes and messages for the activity.

Fault Tab
In the Fault tab, you can find the error code and error message of the Delete activity.

For more detailed information, see Error Codes.

The following table lists the error schema elements in the Fault tab of the Delete activity:

Error Schema
Element Data Type Description

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.

msg String The error messages that are returned by the plug-in.

msgCode String The error code that is returned by the plug-in.
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Error Schema
Element Data Type Description

msg String The error messages that occur when establishing the web
service connection between the plug-in and Marketo.

msgCode String The error code that is returned when establishing the web
service connection between the plug-in and Marketo.
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Working with the Sample Project

The plug-in packages a sample project with the installer. The sample project shows how TIBCO
ActiveMatrix BusinessWorks Plug-in for Marketo works.

After installing the plug-in, you can locate the sample project in the TIBCO_HOME/bw/palettes/
marketo/version_number/samples directory. This sample project contains three processes:
ImportLeads-RequestCampaign, DeleteImportedLeads and Upsert-Delete.

● The ImportLeads-RequestCampaign sample process shows how to use TIBCO ActiveMatrix
BusinessWorks Plug-in for Marketo to retrieve lists, import leads, and request campaigns. See 
Running the ImportLeads-RequestCampaign Process.

● The Upsert-Delete sample process shows how to use TIBCO ActiveMatrix BusinessWorks Plug-in
for Marketo to upsert, retrieve, and delete leads. See Running the Upsert-Delete Process.

● The DeleteImportedLeads sample process shows how to use TIBCO ActiveMatrix BusinessWorks
Plug-in for Marketo to retrieve and delete leads. See Running the DeleteImportedLeads Process.

Importing Sample Projects
Before running the project, you must import the sample project to TIBCO Business Studio.

Procedure

1. Start TIBCO Business Studio by using one of the following ways:

● Microsoft Windows: click Start > All Programs > TIBCO > TIBCO_HOME > TIBCO Business
Studio version_number > Studio for Designers.

● Mac OS and Linux: run the TIBCO Business Studio executable file located in the TIBCO_HOME/
Studio/version_number/eclipse directory.

2. From the menu, click File > Import.

3. In the Import dialog, expand the General folder and select Existing Studio Projects into Workspace
item. Click Next.

4. Click Browse next to the Select archive file field to locate the samples. Click Finish.
The sample project is located in the TIBCO_HOME/bw/palettes/marketo/version_number/
samples directory.

Result

The sample project is imported to TIBCO Business Studio.
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Configuring Module Properties
After importing the MarketoSample project, configure the module properties before running the
processes.

Procedure

1. Extract the MarketoSample.zip file in the TIBCO_HOME/bw/palettes/marketo/version_number/
samples directory to a temporary folder.

2. In the Project Explorer view, double-click Module Descriptors > Module Properties.

3. In the Module Properties panel, expand the MarketoCredentials folder and configure the following
fields:

● MarketoURL: enter the endpoint used to connect to Marketo REST API.

● MarketoIdentityURL: enter the identity URL used to generate an access token.

● ClientID: enter a client ID used to connect to Marketo Rest API.

● ClientSecret: enter a client secret used to generate an access token.

4. Expand the MarketoSample folder and configure the following fields:

● ProjectLocation: enter the value of ProjectLocation with the full path of the directory where you
extract the MarketoSample.zip file in Step 1, and then add a slash at the end of the full path.

● MarketoListName: enter a list name.

● WestRegionList: enter a region list name.

● WestRegionCampaign: enter a region campaign name.

Create lists (MarketoListName, WestRegionList) and Campaign
(WestRegionCampaign) on a Marketo instance. Campaign must be created with
Campaign is Requested trigger and source must be Web service API.

5. On the toolbar, click Save  to save your changes.

You must configure these parameters with your own. The parameters in the sample are
only examples for your reference.
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Running the Sample Processes
After configuring the module properties of the sample projects, you can run the sample processes to see
how TIBCO ActiveMatrix BusinessWorks Plug-in for Marketo works.

Running the ImportLeads-RequestCampaign Process
The ImportLeads-RequestCampaign process shows you how to retrieve lists, add leads to a list, retrieve
leads from a list, import leads, retrieve campaigns, and request campaigns.

Prerequisites

Before running the sample project, you must import the sample project to TIBCO Business Studio and
configure the module properties. See Importing Sample Projects and Configuring Module Properties.

Procedure

1. In the Project Explorer view, expand the MarketoSample folder, and then double-click Processes >
sample > ImportLeads-RequestCampaign.bwp.

2. Expand Module Descriptors and double-click Components. By default, the ImportLeads-
RequestCampaign and Upsert-Delete process are listed in the Components editor. Ensure the
ImportLeads-RequestCampaign component is selected in the Component Configurations area. To

remove the process that you do not want to run, click Remove Launch .

3. On the toolbar, click Save All  to save your changes.

4. From the menu, click Run > Run Configurations .

5. In the Run Configurations dialog, expand BusinessWorks Application and click BWApplication.
Click the Applications tab and select the check box next to MarketoSamples.application.

6. Click Run to run the process.

7. Click Terminate  to stop the process.
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Configurations for the ImportLeads-RequestCampaign Process

The ImportLeads-RequestCampaign process contains the retrieve lists, import leads, and request
campaigns activities.

The following table lists the activities in the ImportLeads-RequestCampaign process:

Activity Description

Timer Starts the process at a specific time.

RetrieveList Retrieves a list from multiple lists according to a list name.

ImportLeads Imports leads to the list retrieved from the previous activity.

CheckImportStatus Verifies if the import progress in the Marketo server is completed or not.

RetrieveLeadsFromList Retrieves leads from the list retrieved from the RetrieveList file.

FilterLeads Filters leads retrieved from the previous activity according to the
matched state.

RetrieveWestRegionList Retrieves a list predefined in the Marketo server.

AddtoList Adds the leads to the list retrieved from the RetrieveList file.

RetrieveCampaign Retrieves a campaign predefined in the Marketo server.

49

TIBCO ActiveMatrix BusinessWorks™ Plug-in for Marketo User's Guide



Activity Description

RequestCampaign Requests a campaign.

WriteErrors Writes and saves the errors to a text file that is located in the
TIBCO_HOME/bw/palettes/marketo/version_number/samples/

MarketoSample folder.

Running the Upsert-Delete Process
The Upsert-Delete process shows you how to upsert, retrieve, and remove leads.

Prerequisites

Before running the sample project, you must import the sample project to TIBCO Business Studio and
configure the module properties. See Importing Sample Projects and Configuring Module Properties.

Procedure

1. In the Project Explorer view, expand the MarketoSample folder, and then double-click Processes >
sample > Upsert-Delete.bwp.

2. Expand Module Descriptors and double-click Components. By default, the ImportLeads-
RequestCampaign and Upsert-Delete process are listed in the Components editor. Ensure the
Upsert-Delete component is selected in the Component Configurations area. To remove the process

that you do not want to run, click Remove Launch .

3. On the toolbar, click Save All  to save your changes.

4. From the menu, click Run > Run Configurations .

5. In the Run Configurations dialog, expand BusinessWorks Application and click BWApplication.
Click the Applications tab and select the check box next to MarketoSamples.application.

6. Click Run to run the process.

7. Click Terminate  to stop the process.
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Configurations for the Upsert-Delete Process

The Upsert-Delete process contains the upsert, retrieve, and delete leads activities.

The following table lists the activities in the Upsert-Delete process:

Activity Description

Timer Starts the process at a specific time.

ReadFile Reads leads records from the Upsert_Leads.csv file

ParseData Parses leads records to the specified schema.

UpsertLeads Inserts leads that have been parsed by the previous activity to the
Marketo server.

RetrieveLeads Retrieves leads that have been inserted by the previous activity.

DeleteLeads Deletes leads that are defined.

WriteFile Writes and saves the exceptions to a text file that is located in the
TIBCO_HOME/bw/palettes/marketo/version_number/samples/

MarketoSample folder.
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Running the DeleteImportedLeads Process
The DeleteImportedLeads process shows you how to retrieve and delete leads.

Prerequisites

Before running the sample project, you must import the sample project to TIBCO Business Studio and
configure the module properties. See Importing Sample Projects and Configuring Module Properties.

Procedure

1. In the Project Explorer view, expand the MarketoSample folder, and then double-click Processes >
sample > DeleteImportedLeads.bwp.

2. Expand Module Descriptors and double-click Components. By default, the ImportLeads-

RequestCampaign and Upsert-Delete process are listed in the Components editor. Click the 
icon and click OK in the Select a BusineessWorks Process dialog to add the DeleteImportedLeads
component to the Component Configurations area. To remove the process that you do not want to

run, click Remove Launch .

3. On the toolbar, click Save All  to save your changes.
4. From the menu, click Run > Run Configurations .
5. In the Run Configurations dialog, expand BusinessWorks Application and click BWApplication.

Click the Applications tab and select the check box next to MarketoSamples.application.
6. Click Run to run the process.

7. Click Terminate  to stop the process.

Configurations for the DeleteImportedLeads Process

The DeleteImportedLeads process contains the retrieve and delete leads activities.
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The following table lists the activities in the DeleteImportedLeads process:

Activity Description

Timer Starts the process at a specific time.

ReadFile Reads leads records from the Lead_Gen.csv file

ParseData Parses leads records to the specified schema.

Retrieve Retrieves leads that have been read by the previous activity.

Delete Deletes leads that are defined.

WriteFile Writes and saves the exceptions to a text file that is located in the
TIBCO_HOME/bw/palettes/marketo/version_number/samples/

MarketoSample folder.
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Managing Logs

When an error occurs, you can check logs to trace and troubleshoot the plug-in exceptions.

By default, error logs are displayed in the Console view when you run a process in the debug mode.
You can change the log level of the plug-in to trace different messages and export logs to a file. Different
log levels correspond to different messages, as described in Log Levels.

Log Levels
Different log levels include different information.

The plug-in supports the following log levels:

Log Level Description

Info Indicates normal plug-in operations. No action is required. A tracing message
tagged with Info indicates that a significant processing step is reached, and
logged for tracking or auditing purposes. Only info messages preceding a
tracking identifier are considered as significant steps.

Error Indicates that an unrecoverable error occurred. Depending on the severity of
the error, the plug-in might continue with the next operation or might stop.

Debug Indicates a developer-defined tracing message.

Setting Up Log Levels
You can configure different log levels for the plug-in and plug-in activities to trace different messages.

If you do not configure any log levels, the plug-in uses the default log level of TIBCO ActiveMatrix
BusinessWorks. The default log level is Error.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open
the logback.xml file.

2. Add the following node in the BusinessWorks Palette and Activity loggers area to specify a log
level for the plug-in.
<logger name="com.tibco.bw.palette.marketo.rest">
   <level value="DEBUG"/>
</logger>

The value of the level element can be Error, Info or Debug.

If you set the log level to Debug, the input and output for the plug-in activities are also
displayed in the Console view. See Log Levels for more details regarding each log level.

3. Optional: Add the following node in the BusinessWorks Palette and Activity loggers area to
specify a log level for an activity:
<logger name="com.tibco.bw.palette.marketo.rest.ActivityNameActivity">
   <level value="DEBUG"/>
</logger>

For example, add the following node to set the log level of the Import activity to Debug:
<logger name="com.tibco.bw.palette.marketo.rest.ImportActivity">
   <level value="DEBUG"/>
</logger>
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The activities that are not configured with specific log levels use the log level configured
for the plug-in.

4. Save the file.

Exporting Logs to a File
You can update the logback.xml file to export plug-in logs to a file.

Procedure

1. Navigate to the TIBCO_HOME/bw/version_number/config/design/logback directory and open
the logback.xml file.

After deploying an application in TIBCO Enterprise Administrator, navigate to the
TIBCO_HOME/bw/version_number/domains/domain_name/appnodes/space_name/

node_name directory to find the logback.xml file.

2. Add the following node to specify the file where the log is exported:
<appender name="FILE" class="ch.qos.logback.core.FileAppender">
   <file>c:/bw6-marketo.log</file>
      <encoder>
        <pattern>%d{HH:mm:ss.SSS} [%thread] %-5level %logger{36}-%msg%n</pattern>
      </encoder>
</appender>

The value of the file element is the absolute path of the file that stores the exported log.

3. Add the following node to the root node at the bottom of the logback.xml file:
<root level="DEBUG">
   <appender-ref ref="STDOUT" />
   <appender-ref ref="FILE" />
</root>

4. Save the file.
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Error Codes

The following table lists the error codes, detailed explanation of each error, and where applicable, ways
to solve different errors.

Error Code Role Category Description Solution

MARKETO_API_ERROR.e
rrorCode =500002

There was a problem

with your request.

Marketo returned error

code {0}.

errorRole BW-Plug-in There is a problem with
your request. Marketo
returned error code {0}.

No action.

MARKETO_SOCKET_TI
MEOUT_ERROR.errorCod
e=500003

The connection has

been timed out. Please

check your connection.

{0}.

errorRole BW-Plug-in The connection has been
timed out. Check your
connection. {0}.

No action.

MARKETO_SHARED_RE
SOURCE_MISSING_ERR
OR.errorCode=500004

The Marketo Shared

Resource is Missing,

Please add shared

resource in

configuration.

errorRole BW-Plug-in The Marketo Shared
Resource is missing, add
shared resource in
configuration.

No action.

MARKETO_INTERNAL_
ERROR.errorCode=500005

Internal Error

Occurred. Please check

error details. {0}

errorRole BW-Plug-in Internal error occurs.
Check error details. {0}.

No action.

MARKETO_UNKNOWN_
HOST_ERROR.errorCode=
500006

The host cannot be

determined. Please

check your connection.

{0}

errorRole BW-Plug-in The host cannot be
determined. Check your
connection. {0}.

Check your
connection
to the host.
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Error Code Role Category Description Solution

MARKETO_REQUEST_SI
GNATURE_ERROR.error
Code=500009

Problem with

generating request

signature, check

Marketo Connection.

Detailed error {0}.

errorRole BW-Plug-in Problem with generating
request signature, check
Marketo Connection.
Detailed error {0}.

Check error
details.

MARKETO_FILEIO_ERR
OR.errorCode=500010

Problem with File

Read/Write. {0}

errorRole BW-Plug-in Problem with File Read/
Write. {0}.

Check error
details.
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